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1. Introduction 
 

1.1 Additional Module STEEL IS 

The Indian Standard IS 800 : 2007 determines rules for the design, analysis and construc-
tion of steel buildings in India. With the additional module STEEL IS from the company  
DLUBAL ENGINEERING SOFTWARE all users obtain a highly efficient and universal tool to design 
structures that have been analyzed in RSTAB according to this standard. 

All typical designs of load capacity, stability and deformation are carried out in the module 
STEEL IS. Different actions are taken into account during the load capacity design, and the 
user has a choice of different interaction designs that are possible according to the Indian 
standard. The allocation of designed cross-sections to classes 1 to 3 makes an important 
part of the design according to IS 800 : 2007. The purpose of this classification is to deter-
mine the range in which the local buckling of cross-section parts limits the load capacity so 
that the rotational capacity of cross-sections can be verified. STEEL IS further automatically 
calculates the required ratios of compressed parts and carries out the classification auto-
matically. 

For the stability design, you can determine for every single member or set of members 
whether buckling is possible about the y-axis and/or z-axis. You can also define lateral sup-
ports. The non-dimensional slenderness ratio and elastic buckling stress are automatically 
determined in STEEL IS on the basis of the boundary conditions. For the design of lateral 
torsional buckling, the elastic critical moment that is necessary for the design can be either 
calculated automatically by STEEL IS or entered manually. The location where the loads are 
applied which influences the elastic critical moment can also be defined in the detailed set-
tings. 

The serviceability limit state represents an important element in static calculations in mod-
ern civil engineering. All relevant values of the maximum deflections can be defined in the 
detailed settings. In STEEL IS, the user can arrange load cases, load groups and combina-
tions individually to different design situations.  

Like other modules, STEEL IS is fully integrated into the RSTAB 7 program. However, it is not 
only an optical part of the program. The results of the module can be incorporated to the 
central printout report. Therefore, the entire design can be easily and especially uniformly 
organized and presented. 

The program includes an automatic cross-section optimization and a possibility to export all 
modified sections to RSTAB. 

Individual design cases make it possible to flexibly analyze separate parts of extensive struc-
tures. 

 

We wish you much success and delight when working with our module STEEL IS. 

Your DLUBAL ENGINEERING SOFTWARE company. 
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1.2 STEEL IS Team 
The following people participated in the development of the STEEL IS module: 

Program Coordinators 
Dipl.-Ing. Georg Dlubal 
Dipl.-Ing. (FH) Younes El Frem 

Ing. Ph.D. Jaromír Křížek 

Programmers 
Ing. Zdeněk Kosáček 
Ing. Ph.D. Jaromír Křížek 
Dipl.-Ing. Georg Dlubal 
Dr.-Ing. Jaroslav Lain 
Ing. Martin Budáč 

Mgr. Petr Oulehle 
Ing. Roman Svoboda 
David Schweiner 
DiS. Jiří Šmerák 

Library of Cross-Sections and Materials 
Ing. Ph.D. Jan Rybín 
Stanislav Krytinář 

Jan Brnušák 

Design of Program, Dialogs and Icons 
Dipl.-Ing. Georg Dlubal 
MgA. Robert Kolouch 

Ing. Jan Miléř 

Testing and Technical Support 
Ing. Martin Vasek 
Ing. Robert Michalovič 
Dipl.-Ing. (BA) Markus Baumgärtel 
Dipl.-Ing. (FH) René Flori 
Dipl.-Ing. (FH) Matthias Entenmann  
Dipl.-Ing. Frank Faulstich 
Dipl.-Ing. (FH) René Flori 

Dipl.-Ing. (FH) Alexandra Lazar 
M. Sc. Dipl.-Ing. (FH) Frank Lobisch 
Dipl.-Ing. (BA) Andreas Niemeier 
Dipl.-Ing. (FH) Walter Rustler 
M. Sc. Dipl.-Ing. (FH) Frank Sonntag 
Dipl.-Ing. (FH) Christian Stautner 
Dipl.-Ing. (FH) Robert Vogl 

Manuals, Documentation and Translations 
Ing. Jaromír Křížek 
Dipl.-Ing. (FH) Robert Vogl 
Mgr. Michaela Kryšková 

Ing. Ladislav Kábrt 
Dipl.-Ü. Gundel Pietzcker 
Ing. Dmitry Bystrov 
 

1.3 Using the Manual 
All general topics such as installation, user interface, results evaluation and printout report 
are described in detail in the manual for the main program RSTAB. Hence, we omit them in 
this manual and will focus on typical features of the additional module STEEL IS. 

During the description of STEEL IS, we use the sequence and structure of the different input 
and output forms of this module. We feature the described icons (buttons) in square brack-
ets, e.g. [Details]. The buttons are simultaneously displayed on the left margin. The names 
of dialogs, forms and particular menus are marked in italics in the text so that they can be 
easily found in the program. 

We also included an index in this manual so that you can quickly look up important terms. 
If you should not find the requested ones, you can also use the search function on our web-
site www.dlubal.com and browse the FAQ list there. 
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1.4 Starting STEEL IS 
It is possible to initialize the add-on module STEEL IS in several ways. 

Main Menu 
You can call up STEEL IS by this command from the main menu of the RSTAB program: 

Additional Modules → Design - Steel → STEEL IS. 

 
Figure 1.1: Main Menu: Additional Modules → Design - Steel → STEEL IS 

Navigator 
Further, it is possible to start STEEL IS from the Data navigator by clicking on the item 

 Additional Modules → STEEL IS.  

 
Figure 1.2: Data Navigator: Additional Modules → STEEL IS 
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Panel 
If results of STEEL IS are already available in the RSTAB position, you can to set the relevant 
design case of this module in the list of load cases in the menu bar. The design criterion on 
members is displayed graphically in the work window of RSTAB using the [Results on/off] 
button.  

The [STEEL IS] button which enables you to start STEEL IS is now available in the panel. 

 

Figure 1.3: [STEEL IS] Button in Panel 
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2. Input Data 
The data of the design cases is entered in different forms of this module. Furthermore, the 
graphic input using the function [Pick] is available for members and sets of members. 

After the initialization of the STEEL IS module, a new window is displayed. In its left part, a 
navigator is shown that enables you to access all existing masks. The roll-out list of all pos-
sibly entered design cases is located above this navigator (see chapter 7.1). 

If STEEL IS is called up for the first time in a position of RSTAB, the following important data 
is loaded automatically:  

• Members and sets of members 
• Load cases, load groups and combinations 
• Materials 
• Cross-sections 
• Internal forces (in the background – if calculated) 

You can switch among the forms either by clicking on the individual navigator items of 
STEEL IS or by using the buttons visible on the left. The [F2] and [F3] function keys can also 
be used to browse the forms in both directions. 

Save entered data by the [OK] button and close the module STEEL IS, while by the [Cancel] 
button you terminate the module without saving data. 

2.1 General Data 
In the form 1.1 General Data, members, sets of members and actions are selected for the 
design. You can specify load cases, load groups and combinations for the ultimate limit 
state and the serviceability limit state design separately in the corresponding registers.  

2.1.1 Ultimate Limit State 

 
Figure 2.1: Form 1.1 General Data - Ultimate Limit State 
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Design of 
You can select both Members and Sets of Members for the design. If only specific objects 
are to be designed, it is necessary to clear the check box All. By doing so, both input boxes 
become accessible and you can enter the numbers of the relevant members or sets of mem-
bers there. With the [Pick] button, you can also select members or sets of members graph-
ically in the RSTAB work window. To rewrite the list of default member numbers, select it by 
double-clicking it and then enter the relevant numbers. 

If no sets of members have been defined in RSTAB yet, they can also be created in STEEL IS 
via the [New Set of Members…] button. The familiar RSTAB dialog to create a new set of 
members opens in which you enter the relevant data. 

Designing sets of members has the advantage that selected members can be analyzed to 
determine the total maxima of the design ratios. In this case, the results forms 2.3 Design 
by Sets of Members and 4.2 Parts List by Set of Members are displayed additionally. 

Existing Load Cases / Load Groups and Load Combinations 
All design-relevant load cases, load groups and load combinations that were created in 
RSTAB are listed in these two sections. The [] button moves the selected load cases, load 
groups or combinations to the list Selected for Design on the right. Specific items can also 
be selected by double-clicks. The [] button transfers all items to the list on the right. 

If an asterisk (*) is displayed at load cases or combinations, as you can see e.g. in Figure  at 
load case 5, they are excluded from the design. It signifies that no loads were assigned to 
these load cases or that they contain only imperfections (as in our example). Furthermore, it 
is only possible to select load combinations for which the minimum and maximum values 
can be determined unambiguously. This restriction is necessary because the calculation of 
the elastic critical moment at lateral buckling requires the unambiguous assignment of mo-
ment diagrams. If an invalid load combination is selected, the following warning appears:  

 
Figure 2.2: Warning when selecting an invalid LC, LG or CO  

A multiple choice of load cases can be done by using the [Ctrl] key, as a routine procedure 
in Windows. Hence, you can select and transfer several load cases to the list on the right 
simultaneously. 

Selected for Design 
The loads selected for the design are listed in the right column. By the [] button you can 
remove the selected load cases, load groups or load combinations from the list. As before, 
the selection can be executed by double-clicks. The [] button removes all items from the 
list. 

Generally, the calculation of an enveloping Or load combination is faster than the analysis 
of all contained load cases or groups. On the other hand, you must keep in mind the above-
mentioned restriction: to determine the maximum or minimum values unambiguously, the 
Or load combination must only contain load cases, groups or combinations which enter the 
combination with the criterion Constant. Moreover, the design of an enveloping load com-
bination makes it a bit difficult to retrace the influence of the contained actions. 
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2.1.2 Serviceability Limit State 

 
Figure 2.3: Form 1.1 General Data - Serviceability Limit State 

Existing Load Cases / Load Groups and Load Combinations 
All load cases, load groups and load combinations that were created in RSTAB are listed in 
these two sections. 

Selected for Design 
Adding load cases and their groups and combinations to the list for the design, resp. re-
moving them from the list is done in the same way like in the previous register tab (see 
Chapter 2.1.1). 

Comment 

You can enter some additional notes here to describe the current design case. 
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2.2 Materials 
This form is divided into two parts. The materials for the design are listed in the upper part. 
In the lower part, the Material Properties of the current material are displayed, i.e. the ma-
terial whose line is selected in the upper form. 

The material properties that are necessary to calculate the internal forces in RSTAB are de-
scribed in detail in the RSTAB manual, Chapter 5.2. All design-relevant material characteris-
tics are stored in the global material library. Those are automatically set as default.  

The units and decimal places of the material properties and stresses can be edited from the 
main menu Options → Units and Decimal Places… (see Chapter 7.4). 

 
Figure 2.4: Form 1.2 Materials 

Material Description 
The materials that have been defined in RSTAB are set by default. You can also enter mate-
rials manually here. If the Material Description corresponds to an entry of the material li-
brary, STEEL IS automatically imports the relevant material properties. 

To select a material from the list, place the cursor in column A and click on the [] button 
or press the [F7] function key. A list is opened that you can see on the left. As soon as you 
have chosen the appropriate material, the material properties are updated in the form be-
low. 

The list of materials includes only materials from the category Steel. How to import materi-
als from the library is described below. 

Import Material from Library 
A considerable number of materials is already stored in a library. Open the library via menu 

Edit → Material Library… 

or by clicking on the button that is visible on the left. 
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Figure 2.5: Material Library Dialog 

In the section Filter Choice, the material category Steel is set by default. In the list Material 
to Select located on the right, you can select a particular material, and in the lower part of 
the dialog you can check its characteristic values. After clicking on [OK] or pressing the [↵] 
key, the material is taken over to the form 1.2 Materials of STEEL IS. 

Chapter 5.2 of the RSTAB manual explains in detail how materials can be filtered, added to 
the library or newly classified. 

Basically, you can also select materials of the categories Cast Iron and Stainless Steel of the 
library. However, you have to bear in mind that those materials are not covered by the Indi-
an Standard IS 800 : 2007. For this reason, it is also impossible to significantly modify the 
material properties in STEEL IS. 
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2.3 Cross-Sections 
This form controls the cross-sections that are to be designed. The parameters of the optimi-
zation can be defined here as well. 

 
Figure 2.6: Form 1.3 Cross-Sections 

Cross-Section Description 
When you open this form, the sections that were defined in RSTAB are set by default, in-
cluding the assigned material numbers. 

The cross-sections can be changed any time for the design. The description of a modified 
cross-section is highlighted in blue color. 

In order to edit a cross-section, enter the new description in the corresponding line or select 
the new section from the library. Open the library by clicking on the [Import Cross-Section 
from Library…] button. Alternatively, place the cursor in the corresponding line and click on 
the [...] button or press the [F7] key. The library opens which is already familiar from RSTAB, 
see Figure 2.7. 

Chapter 5.3 of the RSTAB manual describes in detail how cross-sections can be selected 
from the library. 

If the cross-sections are different in STEEL IS and RSTAB, both cross-sections are shown in 
the graphic window next to the table. The internal forces of RSTAB are then used for the 
stress design of the cross-section that is set in STEEL IS. 
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Figure 2.7: Cross-Section Library 

Coordinate System 
The y-z coordinate system is applied for cross-sections in accordance with RSTAB, see the 
figure on the left. The y-axis represents the major and the z-axis the minor axis of the cross-
section. This coordinate system is used in all results forms as well (see chapter 4). 

Tapered Member 
In case of tapered members with different cross-sections at the member start and member 
end, both cross-section numbers are stated in two lines, following the definition in RSTAB. 
You can design tapered members in STEEL IS if the following condition is fulfilled: an equal 
number of stress points is required at both member ends. 

For example, the normal stresses are calculated from the moments of inertia and from the 
centroidal distances of the stress points. If the start and end cross-sections of the tapered 
member have different numbers of stress points, STEEL IS cannot interpolate the intermedi-
ate values. An error message appears before the calculation: 

 
Figure 2.8: Warning in Case of Incompatible Cross-Sections  

To check on the stress points of the cross-section, you can display them including their 
numbers: Select the cross-section in form 1.3 and then click on the [Info about Cross-
Section…] button. 
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Info about Cross-Section 
There are various display options for stress points and c/t cross-section parts in this dialog. 

 
Figure 2.9: Info about cross-section Dialog 

The currently selected cross-section is displayed in the right part of the dialog. The buttons 
below have the following functions: 

 

 
Table 2.1: Buttons for Cross-Section Graphics  

Button Function 

 The stress points are switched on and off. 

 The cross-section parts (c/t) are switched on and off.  

  The numbering of stress points, resp. of cross-section parts (c/t) is switched 
on and off. 

 The details of stress points, resp. of cross-section parts (c/t) are displayed. 

 The dimensioning of the cross-section is switched on and off. 

 The principal axes of the cross-section are switched on and off. 
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Max. Design Ratio 
Due to this column, you can decide whether to carry out an optimization. The column is on-
ly displayed when STEEL IS has designed the cross-sections. It becomes visible from the data 
and the colored relation scales in this column which cross-sections have a low design ratio 
and therefore are oversized, resp. which are overstrained and therefore are too weak. 

Optimize 
Every cross-section can be optimized. During the optimization process, the cross-section 
within the same group of cross-sections is determined on the basis of the internal forces 
from RSTAB which fulfills best the maximum design ratio. Figure 2.6 shows how the optimi-
zation of a particular cross-section is set by ticking the corresponding box in column D. 

The maximum allowable design ratio for the optimization is controlled in the dialog Details, 
see chapter 3.1. Further information on the optimization of cross-sections can be found in 
chapter 7.2 of this manual. 

Remark 
In this column, the references to footnotes (below the list of cross-sections) are shown.  

If the message Inadmissible Cross-Section No. XX appears before the design, then this due 
to a cross-section which is not contained in the cross-section library. It may be a user-de-
fined cross-section or a cross-section that was not calculated in the module SHAPE-THIN. 
Via the [...] button in column B Cross-section Description you can set a cross-section that is 
suitable for the design (see Figure 2.7 with following remarks). 
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2.4 Lateral Intermediate Supports 
In this form, lateral intermediate supports on members can be defined. The program always 
assumes these supports as perpendicular to the minor axis z (see Figure 2.9) of the cross-
section. Hence, it is possible to change the effective lengths of the member that are im-
portant for the design of column buckling and lateral torsional buckling. It is also important 
to know that lateral intermediate supports are considered as a forked supports for the de-
sign.  

 
Figure 2.10: Form 1.4 Lateral Intermediate Supports 

In the upper part of this form, up to nine lateral intermediate supports can be created per 
member. The lower part of the form displays the summary of the entered data for every 
single member. 

Lateral intermediate supports can be defined either by directly entering the distances or by 
specifying the support locations Relatively. For the latter, it is necessary to tick the associat-
ed check box below the list. The relative distances of the supports are then calculated from 
the member lengths. 
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2.5 Effective Lengths - Members 
The form 1.5 consists of two parts so that a good overview of the data is provided. In the 
upper table, the buckling length coefficients kcr,y and kcr,z, the effective lengths KLy and KLz 
and the Lateral-torsional Buckling coefficients K and Kw are summarized for every member. 
In the lower part of this form, detailed information on the member that is selected in the 
upper table is displayed. The lower table contains all information about the relevant lengths 
of this member. 

 
Figure 2.11: Form 1.5: Effective Lengths - Members 

The effective lengths for the column buckling about the minor principal axis are automati-
cally loaded from the previous form 1.4. If the member is divided into different lengths by 
lateral intermediate supports, then no values are displayed in the corresponding columns D 
and G of form 1.5. It is possible to change the buckling length coefficients both in the sum-
mary table in the upper part and in the detailed settings in the lower part. The data of the 
corresponding part of this form is then updated automatically. The buckling length of a 
member can also be defined graphically by using the function [Pick]. 

The tree structure in the table Settings for Member No. includes the following parameters: 

• Cross-section 

• Length (actual length of the member)  

• Buckling Possible (cf column A)  

• Buckling about Axis y (buckling lengths, cf columns B - D) 

• Buckling about Axis z (buckling lengths, cf columns E - G) 

• Lateral-torsional Buckling (buckling length coefficients, cf columns H - J) 

It is also possible to modify the Buckling Length Coefficients in the relevant directions and 
decide whether the buckling design is to be executed. If a buckling length coefficient is 
changed, the respective effective member length is modified automatically.  
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Buckling Possible 
For the buckling and the lateral torsional buckling design, it is necessary for the member to 
transfer compression forces. Members that cannot transfer compression forces due to their 
definition (e.g. tension members, elastic foundations, rigid couplings) are a priori excluded 
from the design in STEEL IS. In such a case, a corresponding comment is displayed in the 
column Comment for this member. 

The column Buckling Possible enables you to classify specific members as compression ones 
or, alternatively, to exclude them from the design. Hence, the check boxes in column A and 
also in table Settings for Member No. control whether the input options for the buckling 
length parameters are accessible for a member.  

Length 
For your information, the actual length of the selected member is displayed in the lower ta-
ble. It is not possible to modify this value. 

Buckling about Axis y resp. Axis z 
The columns Buckling Possible control whether members are prone to buckling about their 
axes y and/or axes z. The axis y represents the "major principal" member axis, the axis z the 
"minor principal" member axis. The buckling length factors kcr can be freely chosen for the 
buckling about the major and minor axes. 

The orientation of the member axes can be checked in the cross-section graphics of form 
1.3 Cross-Sections (see Figure 2.6). In the RSTAB work window, which can be opened any 
time via the [Graphic] button, you can display the member axes in the Display navigator. 

 
Figure 2.12: Displaying the Local Member Axes in the Display Navigator of RSTAB 

If buckling is possible about one or both member axes, the precise values can be entered in 
columns C and D respectively F and G or in table Settings for Member No. below. 
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If you define the buckling length coefficient kcr, the buckling length KL is determined by 
multiplying the member length L with this buckling length coefficient. 

Via the [...] button at the end of the KL input field, you can select two nodes in RSTAB work 
window graphically. Their distance then defines the buckling length. 

Lateral-Torsional Buckling 
Column H controls whether a lateral-torsional buckling design is to be performed. In col-
umns I and J, you can define the effective length factor K and warping restraint factor Kw. 
These two factors have an influence on the elastic critical moment at lateral-torsional buck-
ling Mcr. To calculate Mcr via the eigenvalue method, an internal member model with four 
degrees of freedom has to be created. The following definitions of K and Kw are used to 
model the degrees of freedom at the supports of this internal member model. 

The effective length factor K corresponds to the following definitions:  

K = 1.0   forked support at both beam ends 

K = 0.7le  restraint at left end and forked support at right end 

K = 0.7ri  restraint at right end and forked support at left end 

K = 0.5   restraint at both beam ends 

K = 2.0le restraint at left end and free right end 

K = 2.0ri  restraint at right end and free left end 

The warping restraint factor Kw corresponds to the following definitions:  

Kw = 1.0 warp-free support at both beam ends 

Kw = 0.7le  warping restraint at left end and forked support at right end 

Kw = 0.7ri  warping restraint at right end and forked foundation at left end 

Kw = 0.5  warping restraint at both beam ends 

Kw = 2.0le   warping restraint at left end and free right end  

Kw = 2.0ri   warping restraint at right end and free left end 

A forked support with K = 1.0 represents a rigid support in the direction of the y-axis and a 
restriction of rotation around the x-axis (longitudinal axis) of the member. In the case of a 
restraint, the rotation about the z-axis is restricted additionally. The abbreviations "le" and 
"ri" characterize the location of the restraint. "Le" is related to the support at the member 
start, "ri" at its end. The orientation of the local member axes is shown in Figure 2.13.    

By the factor Kw, the fourth degree of freedom on the support is defined. It has to be deter-
mined whether warping is possible for the cross-section or not. Regarding the fact that the 
internal member model uses only four degrees of freedom, no more degrees of freedom 
(displacements in directions x and z) have to be defined. 

The coefficients K and Kw are related to the member start or member end. You have to be 
very careful if intermediate supports have been defined. Intermediate supports divide the 
member into several parts for the design. Thus, intermediate supports are to be avoided for 
cantilever beams because the result would be statically deficient pieces with fork-type sup-
ports on only one side each. 

 

Figure 2.13: Member Axes for Factors K and Kw 
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The check box Set Input for Members No.: is located beneath the tree structure. If you tick 
this box, the data entered consequently will become valid for specific resp. All members. 
You can select the members graphically using the function [Pick] or enter their numbers 
manually. This option is useful when you want to assign the same boundary conditions to 
several members. Please notice that this function must be activated prior to data entering. 
If you define the data and choose this option later, the data will not be re-assigned. 

Comment 
You can insert your own remarks in the last column for every member, e.g. to explain the 
defined buckling lengths. 

2.6 Effective Lengths - Sets of Members 
The input form 1.6 controls the effective lengths for sets of members. It is only available if 
one or more sets of members have been selected in form 1.1 General Data. 

This form is very similar to the previous form 1.5. With regard to the effective lengths for 
buckling about the major and minor axes of the cross-sections, it is identical to form 1.5. 
There are differences, however, as far as the parameters for lateral-torsional buckling are 
concerned. These are defined by means of specific boundary conditions in forms 1.7 and 
1.8 (see Chapters 2.7 and 2.8). 

 
Figure 2.14: Form 1.6: Effective Lengths - Sets of Members 
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2.7 Nodal Supports - Sets of Members 
The stability design is based on the loads and the boundary conditions of the selected sets 
of members. The value of the critical factor αcr has to be determined for the entire set of 
members in order to obtain the critical moments Mcr which are necessary for the design. To 
determine this value, a planar member structure with four degrees of freedom per node is 
created. The specific support conditions are defined in form 1.7. This form is only available 
if you have selected one or more sets of members in form 1.1 General Data.  

 
Figure 2.15: Form 1.7: Nodal Supports - Set of Members 

To define the nodal supports, the orientation of the axes within a set of members is im-
portant. The program internally checks the location of the relevant nodes and then deter-
mines the axis system for the nodal supports that are to be defined in form 1.7 (see Figure 
2.16 to Figure 2.19). 

 
Figure 2.16: Auxiliary Coordinate System for Nodal Supports of Set of Members 

If all members within the set of members lie on a straight line as we see in Figure 2.16, the 
local coordinate system of the first member in this set is applied as auxiliary coordinate sys-
tem for the entire set of members. 
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Figure 2.17: Auxiliary Coordinate System for Nodal Supports of Set of Members  

Even if the members within a set do not lie on a straight line, they still must lie in a plane. 
We can see a vertical plane in Figure 2.17. In this case the axis X’ is horizontal and in the 
plane direction. The axis Y’ is also horizontal, but perpendicular to the axis X’. The axis Z’ 
points vertically downwards. 

 
Figure 2.18: Auxiliary Coordinate System for Nodal Supports of Set of Members  

If the members are located in a horizontal plane, the axis X’ is parallel with the axis X of the 
global coordinate system. The axis Y’ then points in the opposite direction of the global axis 
Z. The axis Z’ is parallel with the axis Y of the global coordinate system. 

 
Figure 2.19: Auxiliary Coordinate System for Nodal Supports of Set of Members 

Figure 2.19 shows the most general case. The members within a set of member do not lie 
on a straight line but are located in one oblique plane. The orientation of the axis X’ is then 
determined by the intersection between the oblique and the horizontal plane. The axis Y’ is 
perpendicular to the axis X’ and is also perpendicular to the oblique plane. The axis Z’ is 
perpendicular to the axes X’ and Y’. 
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2.8 Member Releases - Sets of Members 
This form is only available if one or more sets of members have been selected in form 1.1 
General Data. If any member in a given set is not able to transfer internal forces correspond-
ing to the degrees of freedom restricted in form 1.7, then nodal releases can be inserted to 
a set of members in form 1.8. There is also the possibility to exactly define on which side the 
release is to act or to place a release at both sides. 

 
Figure 2.20: Form 1.8: Member Releases - Set of Members 
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2.9 Serviceability Data 
The final input form includes different possibilities for the serviceability design. It is only 
displayed if the serviceability limit state design has been selected in form 1.1 General Data 
(cf Figure 2.3). 

 
Figure 2.21: Form 1.9: Serviceability Data 

In column A, you can refer the deformation to individual members, lists of members or sets 
of members. In column B, the relevant members or sets of members can be selected graph-
ically by using the function [Pick]. The reference lengths l in column D are then filled auto-
matically. The Reference Length is set as the length of the member or the entire length of 
the set of members resp. list of members. It can be changed Manually by using the corre-
sponding checkbox in column C and setting the value in column D. 

In column E, you specify the governing Direction for the serviceability design. Column F 
controls whether Camber is to be taken into account as well. 

For a correct determination of the serviceability limit states, the Beam Type (beam or canti-
lever) is very important. It can be entered in column G. 
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3. Calculation 
 

3.1 Details 
A particular design is carried out with the internal forces calculated in the RSTAB program. 
Before the [Calculation] you should check the detailed setting for the design. Open the ap-
propriate dialog from every input or output mask by clicking on the [Details…] button. 

 
Figure 3.1: Details Dialog 

Check of Maximum Effective Slenderness Ratio 
It is possible to define the maximum effective slenderness ratio for members with tension 
and compression or flexure. These maximum values are compared with the actual member 
slendernesses in table 3.3 which is available after the calculation (see Chapter 4.8). 

Serviceability Limits (Deflections) 
In section Serviceability Limits, it is possible to set the maximum allowable deflection used 
in for the serviceability limit state design. The two selection fields below control whether 
the Deformation is to be related to the undeformed model or to an imaginary connecting 
line between the shifted start and end nodes of the member resp. set of members within 
the deformed structure. 

Stability Analysis 
This section controls globally whether an analysis of stability is to be carried out. If the box 
is unchecked, the input forms 1.4 to 1.8 are not active.  
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Determination of Elastic Critical Moment for LTB 
The option to calculate Mcr Automatically by Eigenvalue Method is set by default. It starts 
from the internal model of finite elements, regarding the following items: 

• Dimensions of gross cross-section 
• Load type and location of load application point  
• Real distribution of moments 
• Lateral forced deformations (on basis of support conditions) 
• Real boundary conditions 

The degrees of freedom of the internal member model are defined by the coefficients K and 
Kw (see Chapter 2.5). 

If the second method of the automatic calculation of the elastic critical moment is chosen, 
then the calculation of the coefficient C1 can be influenced via the [Info…] button. The coef-
ficients C2 and C3 are calculated automatically by the eigenvalue method again. If there are 
loads applied on a member, their application point has to be specified because they can 
have stabilizing or destabilizing effects, subject to the application point. The Point of Load 
Application can be set below. 

Partial Safety Factors 
It is possible to separately modify the partial safety factors of the material γm0  and γm1 for 
Yielding and Buckling or for Ultimate Stress. These factors are used in all cross-section and 
stability checks. 

Structure Type 
The structure type can be either Non-sway or Sway, which affects the calculation of Cmy and 
Cmz. For a sway-type structure, the values of Cmy and Cmz are assumed as 0.9. 

Limit Load for Special Cases 
It is possible to neglect small stresses due to bending, compressive forces and torsion and, 
thus, allow a simplified design which eliminates negligible internal forces. In this dialog sec-
tion, the limits of these internal forces or stresses can be entered. Those are defined as the 
ratios between existing internal forces or stresses and the corresponding resistances of each 
cross-section. 

Options  
Cross-sections of the class 1 or 2 are not designed elastically in STEEL IS. If needed, the elas-
tic design can be activated for those cross-section classes. 

Cross-section Optimization 
Cross-sections can be optimized if the Optimize option is chosen in form 1.3 Cross-sections 
(see Figure 2.6). The dialog Details enables you to set the maximum allowable design ratio 
as a limit for the optimization process. 

Display Results Tables 
In this section, the results tables can be specified which are to be displayed, inclusive of a 
parts list. The individual results tables are described in Chapter 4. 
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3.2 Start Calculation  
In all input forms of STEEL IS, you can start the design by clicking the [Calculation] button. 

At first, STEEL IS searches for the results of the selected load cases, groups and combina-
tions of load cases. If they are not found, the calculation of the governing internal forces in 
RSTAB is started. The calculation parameters of RSTAB are used for this analysis. 

If cross-sections are to be optimized (see chapter 7.2), the required sections are calculated 
and relevant designs are carried out. 

The STEEL IS design can be also started from the RSTAB interface. All design cases of the 
add-on modules are displayed in the To Calculate dialog similar to load cases or groups. 
Open this dialog in RSTAB via the main menu 

Calculate → To Calculate… 

 
Figure 3.2: To Calculate Dialog 

If the design cases of STEEL IS are missing in the list Not Calculated, it is necessary to tick 
the check box Show Additional Modules. 

The [] button transfers selected design cases to the list on the right. You can then start 
the calculation by the [Calculate] button.  

The calculation of a specific STEEL IS design case can also be directly started from the 
toolbar. Set the required design case in the list and then click on the [Results on/off] button. 

 
Figure 3.3: Direct Calculation of Design Case from STEEL IS in RSTAB 

A dialog appears in which you can watch the design process. 
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Figure 3.4: Calculation in STEEL IS 
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4. Results 
 

4.1 Design by Load Case 
Table 2.1 Design by Load Case is displayed immediately after the design. In the upper part 
of this table, a summary of all designs for every load case, load group and combination is 
displayed. The lower part includes all details of the material properties, design internal forc-
es and design data of the load case which is selected in the upper part of this table.  

The results tables 2.1 to 2.5 contain the detailed design summaries according to different 
selection criteria. Tables 3.1 and 3.2 include the governing internal forces. In table 3.3, the 
member slendernesses are compared with the maximum values as set in dialog Details (see 
Chapter 3.1). The parts lists are displayed in the last two tables 4.1 and 4.2.  

The results tables are accessible from the navigator in STEEL IS. You can also switch among 
the tables by using the buttons visible on the left or the functional keys [F2] and [F3]. 

Save the results by the [OK] button and close STEEL IS. 

In this chapter, we describe the particular tables in the given order. The following chapter 5 
Evaluation of Results is devoted to the evaluation and checking of results. 

 
Figure 4.1: Table 2.1 Design by Load Case 

Description 
The descriptions of the load cases, load groups and combinations that are decisive for every 
relevant type of design are displayed in this column. 

Member No. 
The number of the member with the highest design ratio is stated for every designed load 
case, load group or load combination. 
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Location x 
The location x on the member where the maximum stress ratio occurs is displayed in this 
column. The following locations x on the member are taken into account:  

• Start and end nodes 
• Internal nodes according to a potential user-defined member division 
• Extreme values of internal forces 

Design 
For every design type and for every load case, load group or load combination the design 
ratios according to the standard are displayed. 

Design according to Formula 
In this column, the equations that were followed in the design are displayed. 

DS 
The Design Situation which is relevant for the design is stated in this column. The first letter 
in the shortcuts U resp.  S stands for "Ultimate Limit State" resp. "Serviceability Limit State", 
the second letter stands for the decisive combination of actions. 

4.2 Design by Cross-Section 

 
Figure 4.2: Table 2.2 Design by Cross-section 

In this table, the maximum stress ratios are displayed for all designed members and for all 
designed load cases, load groups and combinations. The results are sorted according to 
cross-sections. For tapered members, both cross-section descriptions are shown in the line 
next to the cross-section number. 
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4.3 Design by Set of Members 

 
Figure 4.3: Table 2.3 Design by Set of Members 

This table is displayed if at least one set of members was selected for design. The maximum 
design ratios are listed according to sets of members. The number of the member with the 
highest design ratio within each set of members is shown as well. 

4.4 Design by Member 

 
Figure 4.4: Table 2.4 Design by Member 
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In this table, the maximum design ratios are arranged according to member numbers. The 
Location x at which the maximum value occurs is stated for every member. 

The description of the individual columns can be found in chapter 4.1. 

4.5 Design by x-Location 

 
Figure 4.5: Table 2.5 Design by x-Location 

This results table lists the maximum values of every member at the following locations x ac-
cording to the member division points of RSTAB: 

• Start and end nodes 

• Internal nodes according to a potential user-defined member division  

• Division points according to the number of member divisions that were set in the 
Calculation Parameters dialog in the Options register in RSTAB 

• Extreme values of internal forces 
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4.6 Governing Internal Forces by Member 
In this table, the governing internal forces are shown which lead to the maximum design 
ratios. 

 
Figure 4.6: Table 3.1 Governing Internal Forces by Member 

Location x 
For every member, the location x on the member with the maximum design ratio is shown. 

Load Case 
In this column, the numbers of the load cases, load groups or combinations whose internal 
forces have the most unfavorable effect are displayed. 

Forces / Moments 
The decisive axial and shear forces as well as the torsional and bending moments are listed 
for every member. 

Design according to Formula 
The last column includes the relevant equations that were followed in the design. 
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4.7 Governing Internal Forces by Set of Members 

 
Figure 4.7: Table 3.2 Governing Internal Forces by Set of Members 

In this results table, the governing internal forces that lead to the maximum design ratios of 
every set of members are shown. 

4.8 Member Slendernesses 

 
Figure 4.8: Table 3.3 Member Slendernesses 
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In table 3.3, the effective slenderness ratios of all designed members are compared with the 
maximum values that were set in the dialog Details (see Chapter 3.1). These ratios are listed 
with respect to the major and minor principal axes. This table provides information on the 
maximum effective slenderness ratios only. It does not give any design results. Members of 
the types tension or cable are excluded from this table. 

4.9 Parts List by Member 

 
Figure 4.9: Table 4.1 Parts List by Member 

Finally, the parts list of all cross-sections that are considered in the given design case is dis-
played. This list contains only designed members by default. If all members of the structure 
are to be included, you can modify the setting in the Details dialog (see Figure 3.1, page 26) 
that can be opened by the [Details] button. 

Part No. 
The same part number is automatically assigned to identical members. 

Cross-section 
In this column, the cross-section descriptions are displayed. 

Number of Members  
The number of identical members is given for each part. 

Length 
This column displays the unit lengths of every single member. 

Total Length 
This column represents the product of the values given in the two previous columns. 
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Surface Area  
The surface area which is related to the total length of the relevant part is calculated on the 
basis of the value ASurf of each cross-section. You can check on this value by clicking on the 
[Info about Current Cross-Section...] button in tables 1.3 or 2.1 to 2.5. 

Volume 
The volume of every part is calculated from the surface area and the total length. 

Unit Weight 
The Unit Weight of the cross-section represents the weight per length of 1 m. In case of ta-
pered cross-sections, the unit weight is calculated as the mean value of both cross-sections. 

Weight  
The value in this column is calculated as the product of values in the columns C and G. 

Total Weight 
The total weight of each part is displayed in the last column. 

Sum 
The sums of the values in the individual columns are given in the final row of this list. The 
cell Total Weight shows the total required amount of steel. 

4.10 Parts List by Set of Members 

 
Figure 4.10: Table 4.2 Parts List by Set of Members 

The last mask in STEEL IS is presented when at least one set of members was selected for 
the design. The advantage of this table is that a parts list is given for the various groups of 
elements (e.g. for a beam). 

The table columns are described in Chapter 4.9. If there are different cross-sections within 
the set of members, the mean values of surface area, volume and unit weight are listed. 
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5. Evaluation of Results 
The design values can be evaluated in different ways. For this, the buttons in the results ta-
bles are very useful which are located below the upper tables each.  

 
Figure 5.1: Buttons for Evaluation of Results 

These buttons have the following functions:  

Button Name Function 

 
Design of Ultimate Limit 
State 

Switch on/off the design results of the ultimate 
limit state 

 
Design of Serviceability 
Limit State 

Switch on/off the design results of the serviceabi-
lity limit state 

 
Show Color Bars in Table 

Switch on/off the color background in the results 
tables according to the reference scale 

 
Show Rows with Ratio > 1 

Show only rows with stress ratios greater than 1 
and, accordingly, the failed design 

 
Show Result Diagrams of 
Current Member  

Open the diagram Result Diagram on Member 
 Chapter 5.2. 

 
Jump to Graphics to 
Change View  

Go to the RSTAB work window in order to change 
the display settings 

 

Pick Member in Graphics 
and Go to This Member in 
Table 

Click on a specific member in the RSTAB window 
whose results values are to be displayed in the 
table 

Table. 5.1:  Buttons in Results Tables 2.1 to 2.5 
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5.1 Results on RSTAB Model 
You can use the RSTAB work window to evaluate the design results. The RSTAB graphics in 
the background can be useful if you want to check the location of a specific member in the 
model: the member that is selected in the STEEL IS results table is also highlighted in the se-
lection color in the RSTAB background graphics. Additionally, an arrow marks the member 
location x which is stated as decisive in the selected line. 

 
Figure 5.2: Selection of Member and Current Location x in RSTAB Model  

If you do not get a favorable view even by moving the STEEL IS window, you can apply the 
so-called View Mode by clicking on the [Jump to Graphics to Change View] button: the 
STEEL IS window is switched off and you can change the view of the RSTAB model. In this 
mode, the functions from the View menu are available, e.g. zoom, move or rotate the view. 

The design ratios can also be displayed on the structural model. Close STEEL IS via the 
[Graphic] button. The design ratios are then shown graphically in the RSTAB work window. 

Similar to the internal forces of RSTAB, you can activate or deactivate the design results by 
the [Results on/off] button. The [Show Result Values] button controls the display of the nu-
merical values in the graphics. 

Regarding the fact that the RSTAB tables are irrelevant to evaluate the STEEL IS results, you 
can deactivate them by using the button visible on the left. 
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A particular design case can be selected from the list of cases in the RSTAB toolbar. 

The display of the results can be also controlled by the Display navigator, using the entry 
Results → Members. The design ratio is displayed Two Colored by default.  

 
Figure 5.3: Display Navigator: Results →  Members → Two Colored 

If you select the Colored results display, the panel colors become available with various op-
tions for the multicolor display. Those are described in Chapter 4.4.6 of the RSTAB manual. 

 
Figure 5.4: Design ratios for Option Cross-sections in the Display Navigator 
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As for the member internal forces, you can set the scale factor for the graphics of the 
design results in the Factors register. If you enter the factor 0 in the input field Member 
Diagrams, the design ratios will be shown with an increased line thickness. 

This graphics can be incorporated to the global printout report (see chapter 0). 

You can return to STEEL IS any time by clicking on the [STEEL IS] button in the panel. 

5.2 Result Diagrams  
In order to view the result diagram of a specific member, the graph of results can be used. 
Select the desired member or set of members in the results table of STEEL IS and then acti-
vate the diagram by the button as seen to the left. This button is located below the upper 
tables of results.  

The result diagrams are also available in the RSTAB window via the main menu 

  Results → Member Results 

or by using the corresponding button in the toolbar. 

A new window is opened in which the result diagrams of the selected member or set of 
members are shown. 

 
Figure 5.5: Result Diagram on Member Dialog 

A particular design case can be selected from the list in the toolbar.  

A detailed description of the Result Diagram on Member dialog can be found in Chapter 
9.8.4 of the RSTAB manual. 



5  Evaluation of Results 

 

 42 Program STEEL IS © 2009 by Dlubal Engineering Software 

 

  

 

5.3 Filtering Results 
The structure of the STEEL IS masks makes it already possible to select the results according 
to certain criteria. Additionally, you can use the filter functions as described in the RSTAB 
manual to graphically evaluate the STEEL IS results.  

Firstly, you can use already defined partial views (cf RSTAB manual, chapter 9.8.6) that 
group certain objects in a favorable way. 

Secondly, you can set the stress ratios as a criterion to filter the results in the RSTAB work 
window. For this, the so-called control panel is to be displayed. If it is not visible, you can 
switch it on via the main menu  

View → Control panel 

or by clicking on the corresponding button in the Results toolbar. 

This panel is described in chapter 4.4.6 of the RSTAB manual. The settings to filter the re-
sults are defined in the Color Spectrum register. As this register is not available in case of 
the two colored stress display, it can be switched on by selecting one of the display options 
Colored or Cross-sections in the Display navigator. 

 
Figure 5.6: Display Navigator: Results → Members → Colored 

For a colored view of the results, you can set in the panel that e.g. only stress ratios greater 
than 0.3 are to be displayed. Furthermore, you can adjust the color spectrum in a way that 
one single color range exactly covers the stress ratio 0.10 (see Figure 5.7). 

By the option Display hidden result diagram (Display navigator, entry Results → Members) 
you can also display stress diagrams that do not satisfy the given condition. Those diagrams 
will then be drawn as dashed lines. 
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Figure 5.7: Filtering Stress Ratios with Customized Color Spectrum  

Filtering Members 
In the Filter register of the control panel, you can enter the numbers of the members whose 
result diagrams are to be shown in the graphics. This function is described in chapter 9.8.6 
of the RSTAB manual. 

Contrary to the partial view function, the entire structure is displayed here. The following 
figure shows the stress ratios in the compressed flange of a footbridge. The other members 
of this structure are also shown in the model but they are without any stress ratios. 

 
Figure 5.8: Filtering Members: Stress Ratios of Footbridge Flange
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6. Printout 
 

6.1 Printout Report 
For the design results of STEEL IS, a printout report can be created to which you can add 
graphics and comments. In this printout report, it is also possible to select which results ta-
bles of STEEL IS are to be printed. 

The printout report is described in detail in the RSTAB manual. In particular, Chapter 
10.1.3.4 Selection of Additional Modules Data is important and deals with the selection of 
input and output data in all add-on modules. 

You can create several printout reports for every design case. For very large structures, it is 
recommended to create several smaller reports instead of a single extensive one. If you cre-
ate a specific report only for the data of the STEEL IS design case, the printout report will be 
processed fairly quickly. 

6.2 Print STEEL IS Graphics 
It is possible to print the stress ratios displayed on the RSTAB model. All graphics can be in-
corporated to the printout report or sent directly to the printer. Chapter 10.2 of the RSTAB 
manual describes in detail how to print graphic displays.  

Results on RSTAB Model 

Every image of the RSTAB work window can be included in the printout report. The current 
STEEL IS graphics is printed by using the main menu 

File → Print… 

or clicking on the corresponding button in the toolbar. 

 
Figure 6.1: Print Button in Toolbar in Main Window 

Result Diagram 

You can also print the result diagrams of members by clicking on the [Print] button in the 
Result Diagram on Member dialog. 

 
Figure 6.2: Print Button in Toolbar of Result Diagram Dialog 

The following dialog opens. 
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Figure 6.3: Graphic Printout Dialog, General Register 

This dialog is described in detail in Chapter 10.2.1 of the RSTAB manual. The remaining two 
register tabs Options and Color Spectrum are also explained there. 

In the printout report, any image of the STEEL IS results can be moved to a different loca-
tion by the Drag&Drop function. It is also possible to adjust inserted images subsequently: 
right mouse click on the relevant entry in the report navigator, then select Properties in the 
context menu. The Graphic Printout dialog is displayed again where the possible changes 
can be set.  

 
Figure 6.4: Graphic Printout Dialog, Options Register 
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7. General Functions 
This chapter describes the commonly used functions of the main menu as well as the export 
options of the design results. 

7.1 STEEL IS Design Cases 
The user has the option to group the members into separate design cases. In this way, it is 
possible e.g. to design separately certain structural parts or elements with specific parame-
ters (limit stresses, partial safety factors, optimization etc.). 

A member or set of members can be analyzed in different design cases without any prob-
lem.  

All design cases created in STEEL IS are contained in the list of load cases and load groups in 
the toolbar in the RSTAB work window. 

Create New STEEL IS Case 
A new design case can be created from the STEEL IS main menu 

File → New Case… 

The following dialog opens: 

 
Figure 7.1: New STEEL IS-Case Dialog 

In this dialog, you need to fill in the (not yet used) Number and Description of the new de-
sign case. After closing the dialog with [OK], the STEEL IS form 1.1 General Data is shown 
where you can define the new design data. 

Rename STEEL IS Case 
The description of a design case can be changed via the STEEL IS main menu 

File → Rename Case… 

The Rename STEEL IS-Case dialog is opened. 

 
Figure 7.2: Rename STEEL IS-Case Dialog  
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Copy STEEL IS Case 
The input data of the current design case can be copied via the STEEL IS main menu 

File → Copy Case… 

The Copy STEEL IS-Case dialog opens. Enter the number and description of the new design 
case into which the selected case is to be copied. 

 
Figure 7.3: Copy STEEL IS-Case Dialog 

Delete STEEL IS Case 
Design cases can be deleted via the STEEL IS main menu 

File → Delete Cases… 

In the Delete Cases dialog, select a specific design case from the list of Available Cases. It 
will be deleted when clicking on [OK] 

 
Figure 7.4: Delete Cases Dialog 
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7.2 Cross-Section Optimization 
The module STEEL IS offers the possibility to optimize cross-sections. For this, select the 
cross-section that is to be optimized in column D resp. E of form 1.3 Cross-sections by tick-
ing the appropriate box (cf Figure 2.6). 

You can also start the optimization of a cross-section via the context menu in the results ta-
bles. 

During the optimization, STEEL IS examines which cross-section within the same cross-
sections series satisfies the design “optimally“, i.e. is the closest to the maximum allowable 
stress ratio which has been defined in the Details dialog (cf Figure 3.1). The required cross-
section properties are calculated on the basis on the internal forces from RSTAB. Finally, the 
cross-section which satisfies the design with the highest possible stress ratio is chosen. For 
this reason, two cross-sections are shown graphically in form 1.3 on the right - the original 
cross-section from RSTAB and the optimized one (cf Figure 7.6). 

When ticking the optimization box for parameterized cross-sections from the library, the 
following dialog appears for you to enter detailed data. 

 
Figure 7.5: Welded Cross-cections - I-Symmetric: Optimize Dialog 

At first, select the parameter(s) that you want to modify in column Optimize. Hence, the 
columns Minimal and Maximal become accessible where the upper and lower limits of the 
optimization parameter can be defined. The column Increment controls in which intervals 
the parameter dimensions vary during the optimization process. 

If you want to Keep Current Side Proportions, tick the corresponding box in the lower part 
of this dialog. Additionally, it is necessary to tick all parameters for the optimization. 

It is not possible to carry out the optimization for combined rolled cross-sections. 

Please keep in mind that during the optimization the internal forces will not be recalculated 
automatically on the basis of the modified cross-sections. It depends on the user’s decision 
when and which cross-sections are to be adapted in RSTAB for a new analysis. The internal 
forces based on the optimized cross-sections may differ considerably due to the changed 
rigidities within the structural model. Thus, we recommend recalculating the internal forces 
after one optimization run and then optimizing the cross-sections once more. 
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It is not necessary to transfer the modified cross-sections to RSTAB manually. Open form 
1.3 Cross-sections and select in the main menu 

Edit → Export All Cross-Sections to RSTAB. 

The option to export the modified cross-sections to RSTAB is also contained in the context 
menu of form 1.3. 

 
Figure 7.6: Context Menu in Form 1.3 Cross-sections 

Before the cross-sections are transferred to RSTAB, a question appears because exporting 
also implies deleting the results. If you then start the [Calculation] in STEEL IS, the internal 
forces of RSTAB and the stresses of STEEL IS are calculated in one calculation run. 

 
Figure 7.7: Question before Transferring Modified Cross-Sections to RSTAB  

In a similar way, you can reload the original cross-sections from RSTAB to STEEL IS by using 
the appropriate functions in the main menu or context menu. Please note that this option is 
only available in form 1.3 Cross-sections. 

If you want to optimize a tapered member, the cross-sections of the member start and of 
the member end are optimized. After that, the moments of inertia are linearly interpolated 
at the intermediate locations of the member. As those are considered by the fourth power, 
the stress design may be inaccurate if there are big differences in height of the start and 
end cross-sections. In such a case, we recommend dividing tapers into several members 
whose start and end cross-sections do not show such big differences. 
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7.3 Import / Export of Materials 
If you change a material in form 1.2 of STEEL IS, you can export it to RSTAB like a cross-
section or also reload the original material from RSTAB to the module. The materials that 
have been modified in the module are highlighted in blue color. 

It is not necessary to transfer the modified materials to RSTAB manually. Instead, open form 
1.2 Materials and choose in the main menu 

Edit → Export all Materials to RSTAB.  

The option to export modified materials to RSTAB is also included in the context menu of 
form 1.2. 

 
Figure 7.8: Context Menu in Form 1.2 Materials  

Before the materials are transferred to RSTAB, a question is shown because exporting also 
implies deleting the results. If you then start the [Calculation] in STEEL IS, the internal forces 
of RSTAB and the stresses of STEEL IS are calculated in one calculation run. 

 
Figure 7.9: Question before Transferring Modified Materials to RSTAB  
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7.4 Units and Decimal Places 
The units and decimal places are centrally managed for RSTAB and all its add-on modules. 
In STEEL IS, open the dialog to set the units via the main menu 

Settings → Units and Decimal Places… 

The familiar RSTAB dialog opens. The module STEEL IS is already set by default. 

 
Figure 7.10: Units and Decimal Places Dialog 

The settings can be stored as a user profile. They can also be applied later in different cases. 
This function is described in Chapter 11.6.2 of the RSTAB manual. 

7.5 Export of Results 
The results of the stress design can be transferred to other programs in different ways. 

Clipboard 

Select the relevant cells in the results tables of STEEL IS and copy them to the clipboard via 
[Ctrl]+[C]. The contents can then be inserted via [Ctrl]+[V] e.g. to some text processing 
program. The headers of the table columns are be exported. 

Printout Report  

The STEEL IS data can be sent to the printout report (cf Chapter 6.1) and then be exported 
via the main menu 

File → Export to RTF File or BauText… 

This function is described in Chapter 10.1.11 of the RSTAB manual. 
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Excel / OpenOffice 

STEEL IS enables you to directly export data to MS Excel or OpenOffice.org Calc. Call up this 
function via the main menu 

File → Export Tables… 

The following dialog opens:  

 
Figure 7.11: Export - MS Excel Dialog 

As soon as you have chosen the relevant options, you can start the export by [OK]. Excel or 
OpenOffice do not need to run in the background, they will be started automatically before 
the export. 

 
Figure 7.12: Results in Excel 
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8. Example 
 

Column with Biaxial Bending 
In the following example, the decisive stability design of buckling and lateral buckling is 
carried out by analyzing the relevant interaction conditions. 

Design Values 
Structure and Loads 

 
Figure 8.1: Structure and Design Loads (γ-fold) 

Internal Forces according to Linear Static Analysis  

             
  N My Mz Vy Vz 

Figure 8.2: Internal Forces 

Design values of static loads: 

P  = 300 kN 
qz = 5.0 kN/m 
Fy = 7.5 kN 
 
Cross-section: HB 225 

Material: IS 513 DD     
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Design Location (Decisive Location x) 
The design proceeds according to locations x, i.e. on defined locations x of an equivalent 
member. The following internal forces act in the decisive location for x = 2.00:  

N = –300.00 kN       My = 10.00 kNm       Mz = 7.50 kNm      Vy = 3.75 kN      Vz = 0.00 kN 

Cross-Section Properties HB 225 

 Cross-Section Properties Symbol Value  Units 

 Cross-section area A 54.90 cm2 
 Moment of inertia about major axis Iy 5300.00 cm4 
 Moment of inertia about minor axis Iz 1350.00 cm4 
 Radius of inertia about major axis ry 9.83 cm 
 Radius of inertia about minor axis  rz 4.96 cm 
 Cross-section weight wt  43.1 kg/m 
 Torsion constant IT 13.28 cm4 
 Warping constant Iw   201318.00 cm6 
 Elastic section modulus about major axis Zey  469.00 cm3 
 Elastic section modulus about minor axis Zez 120.00 cm3 
 Plastic section modulus about major axis Zpy  514.78 cm3 
 Plastic section modulus about minor axis Zpz 233.22 cm3 

 Buckling class about major axis BCy b  
 Buckling class about minor axis BCz c  

Material Properties IS 513 DD 

 Material Properties Symbol Value  Units 

 Modulus of elasticity E 200000 N/mm2 
 Modulus of rigidity G 76900 N/mm2 
 Characteristic yield stress  fy 250 N/mm2 
 Characteristic ultimate tensile stress  fu 270 N/mm2 
 Partial safety factor γm0 1.1  

Classification of Cross-section 

1.0  ´250 / 250 f / 250´ y ===ε  

Classification of the Flange 

b = 112.5 mm 

tf = 9.1 mm 

9.4    1.0 9.4     9.4    1,f =⋅=ε=λ  

10.5    1.0 10.5     10.5    2,f =⋅=ε=λ  

15.7    1.0 15.7     15.7    3,f =⋅=ε=λ  

f,3
f

    15.7    363.12  
1.9
5.112

t
b

λ=≤==  

Class of the flange is 3. 
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Classification of the Web 

2
Aw, mm / N 72.3  −=σ  

2
Bw, mm / N 37.0  −=σ  

d = 206.8 cm 

tw = 6.8 cm 

0.939    1.1) / (250 / 
6.8  206.8

10  300
    ) / (f /  

t  d
P

    r
3

moy
w

1 =
⋅

⋅
=γ

⋅
=  

0.240    1.1) / (250 / 
10 54.9

10 300
    ) / (f /  

A
P

    r
2

3

moy2 =
⋅

⋅
=γ=  

43.329    
0.939 1

1.0  84
  

r1
 84

    
1

1,w =
+

⋅
=

+
ε

=λ  

43.604    
0.939 1.5 1
1.0  105

    
r 5.11

 105
    

1
2,w =

⋅+
⋅

=
+

ε
=λ  

85.085    
0.240 2 1
1.0  126

    
r 21
 126

    
2

3,w =
⋅+

⋅
=

+
ε

=λ  

w,1
fw

    43.329    412.30     
8.6

8.206
    

t
d

λ=≤==  

Class of the web is 1. 

Class of the cross-section is 3. 

 Classification in STEEL IS  

 Cross-section Classification - Class 3 
 Flange 
 - Width  b 11.25 cm  Table 2 
 - Thickness tf 0.91 cm  Table 2 
 - Yield Stress Ratio εf 1.000   Table 2 
 - Maximal Ratio for Class 1 λf,1 9.400   Table 2 
 - Maximal Ratio for Class 2 λf,2 10.500   Table 2 
 - Maximal Ratio for Class 3 λf,3 15.700   Table 2 
 - Ratio b/tf 12.363  ≤  λf,3  
 - Class of Flange  3   Table 2 
 Web 
 - Stress at the End of Web σw,A -72.3 N/mm2   
 - Stress at the End of Web σw,B -37.0 N/mm2   
 - Depth  d 20.68 cm  Table 2 
 - Thickness tw 0.68 cm  Table 2 
 - Area of Cross-Section A 54.90 cm2   
 - Design Yield Stress fyd,w 227.3 N/mm2   
 - Axial Compressive Force P -300.000 kN   
 - Yield Stress Ratio εw 1.000   Table 2 
 - Stress Ratio r1 0.939   Table 2 
 - Stress Ratio r2 0.240   Table 2 
 - Maximal Ratio for Class 1 λw,1 43.329   Table 2 
 - Maximal Ratio for Class 2 λw,2 43.604   Table 2 
 - Maximal Ratio for Class 3 λw,3 85.085   Table 2 
 - Ratio d/tw 30.412  ≤  λw,1  
 - Class of Web  1   Table 2 
 Class of Cross-Section  3   Table 2 
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Buckling about y-Axis (Major Axis)  

KLy = 4.0 m 

1.2  1.0  
225
225

  
b
h

f
<==       tf = 9.1 mm < 100 mm   ⇒  Buckling Class b 

  mm / N 1191.0    
98.25) / 10  (4

200000  
  

)r / (KL

E 
  f 2

23

2

2
yy

2

ccy =
⋅

⋅π
=

π
=  

0.458   
1191.0

250
  

f

f
  

ccy

y
y ===λ  

αy = 0.340    (Table 7) 

φy = 0.5 [1 + αy(λy – 0.2) + λy
2] = 0.5 [1 + 0.340 (0.458 – 0.2) + 0.4582] = 0.649 

0.902    
])458.0   (0.649  [0.649

1
    

])  (  [

1
  

0.5220.52
y

2
yy

y =
−+

=
λ−φ+φ

=χ  

  mm / N  205.1    1.1 / 250  0.902     / f   f 2
m0yycdy =⋅=γχ=  

kN 1125.82    205.1  10 54.9   f   A  P 2
cdyedy =⋅⋅==  

0.27    1125.82 / 300.0   P / P   n dyy ===  

Design in STEEL IS     

 Effective Length KLy 4.000 m   
 Buckling Class BCy b   Table 10 
 Euler Buckling Stress fccy 1191.0 N/mm2  7.1.2.1 
 Slenderness Ratio  λy 0.458   7.1.2.1 
 Imperfection Factor αy 0.340   Table 7 
 Auxiliary Factor φy 0.649   7.1.2.1 
 Stress Reduction Factor χy 0.902   7.1.2.1 
 Design Compressive Stress fcdy 205.1 N/mm2  7.1.2.1 
 Design Compressive Strength Pdy 1125.82 kN  7.1.2 
 Axial Design Ratio ny 0.27   9.3.2.2 

Buckling about z-Axis (Minor Axis)  

KLz = 4.0 m 

Buckling Class c 

  mm / N 303.4    
49.6) / 10  (4

200000  
  

)r / (KL

E 
  f 2

23

2

2
zz

2

ccz =
⋅

⋅π
=

π
=  

0.908   
303.4
250

  
f

f
  

ccz

y
z ===λ  

αz = 0.490    (Table 7) 

φz = 0.5 [1 + αz(λz – 0.2) + λz
2] = 0.5 [1 + 0.490 (0.908 – 0.2) + 0.9082] = 1.085 

0.595    
])908.0   (1.085  [1.085

1
    

])  (  [

1
  

0.5220.52
z

2
zz

z =
−+

=
λ−φ+φ

=χ  

  mm / N  135.2    1.1 / 250  0.595     / f   f 2
m0yzcdz =⋅=γχ=  
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kN 742.5    135.2  10 54.9   f   A  P 2
cdzedz =⋅⋅==  

0.40    742.5 / 300.0   P / P   n dzz ===  

 Design in STEEL IS 

 Effective Length KLz 4.000 m   
 Buckling Class BCz c   Table 10 
 Euler Buckling Stress fccz 303.4 N/mm2  7.1.2.1 
 Slenderness Ratio  λz 0.908   7.1.2.1 
 Imperfection Factor αz 0.490   Table 7 
 Auxiliary Factor φz 1.085   7.1.2.1 
 Stress Reduction Factor χz 0.595   7.1.2.1 
 Design Compressive Stress fcdz 135.2 N/mm2  7.1.2.1 
 Design Compressive Strength Pdz 742.5 kN  7.1.2 
 Axial Design Ratio nz 0.40   9.3.2.2 

Lateral Torsional Buckling 

The check for lateral torsional buckling is based on the calculation of the critical moment 
Mcr. A forked support without any warping restraint is assumed for both member ends. The 
point of load application is set at the upper flange (this point can be modified in the de-
tailed settings, see Chapter 3.1). 

K = 1.0     (Free rotation about weak axis at both ends) 

Kw = 1.0 

LLT = 4.0 m 

mm 112.5    
2

225
    

2
h

    yg ===   (Load applied at the upper flange) 

yj = 0.0     (Symmetrical cross-section)  

C1 =́ 1.132 

C2 =́ 0.458 

kNm 192.9           

 5.112  458.0  )5.112  (0.458  
10  1350  200000 

(4000) 10  13.28  76900
              

 
10  1350  200000 

(4000) 10  13.28  76900
  

10  1350

10  201318
 

0.1
0.1

             

 
(4000)

10  1350  200000  
  1.132           

  ´y C  )y(C  
I E 

)(L I G
  

I
I

 
K
K

 
)(L

I E 
C     M

5.0
2

42

24

42

24

4
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2
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2

w
2
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 1cr
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 0.911    514.78 / 469.0    ´Z /Z    py eyby ===β       (Cross-section class 3) 

 0.779    
10  192.9

250  10 514.78  0.911
  

M

f Z 
   

6

3

 cr

ypyby
LT =

⋅

⋅⋅⋅
=

β
=λ  

0.21   ́LT =α               (Rolled cross-section) 

φLT = 0.5 [1 + αLT(λLT – 0.2) + λLT
2] = 0.5 [1 + 0.210 (0.779 – 0.2) + 0.7792] = 0.865 
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0.807    
])779.0   (0.865  [0.865

1
    

])  (  [

1
  

0.5220.52
LT

2
LTLT

LT =
−+

=
λ−φ+φ

=χ  

  mm / N  183.5    1.1 / 250  0.807     / f     f 2
m0yLTbd =⋅=γχ=  

kNm 86.044    183.5  514.78   0.911    ´f Z    M bdpybydy =⋅⋅=β=  

Design in STEEL IS 

 Effective Length Factor K 1.000   Annex E 
 Warping Restrained Factor Kw 1.000   Annex E 
 Length of the Segment L 4.000 m   
 Effective Length  LLT 4.000 m   
 Load Application Position yg 11.25 cm  Annex E 
 Cross-section Factor yj 0.00 cm  Annex E 
 Moment Factor C1 1.132   Eigenvalue 
 Moment Factor C2 0.458   Eigenvalue 
 Elastic Critical Moment Mcr 192.989 kNm  Annex E 
 Slenderness Ratio λLT 0.779   8.2.2 
 Imperfection Parameter αLT 0.210   8.2.2 
 Auxiliary Factor (LT 0.865   8.2.2 

 Stress Reduction Factor χLT 0.807   8.2.2 

 Design Compressive Stress fbd 183.5 N/mm2  8.2.2 
 Bending Factor βby 0.911   8.2.2 
 Bending Strength Mdy 86.044 kNm  8.2.2 

 Bending 

 0.911    514.78 / 469.0    ´Z /Z    py eyby ===β  

0.515    233.22 / 120.0    ´Z /Z    pz ezbz ===β  

kNm 106.591    1.1 / 250  10  514.78  0.911     / f Z    M 3
m0ypybydy =⋅⋅⋅=γβ=  

kNm 27.273    1.1 / 250  10  233.22  0.515     / f Z    M 3
m0ypzbzdz =⋅⋅⋅=γβ=  

Design in STEEL IS 

 Bending Factor βby 0.911   8.2.2 
 Bending Factor βbz 0.515   8.2.2 
 Bending Strength Mdy 106.6 kNm  8.2.1.2 
 Bending Strength Mdz 27.3 kNm  8.2.1.2 
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Equivalent Uniform Moment Factors and Interaction Factors 
Bending about y-Axis (Major Axis) 

The equivalent uniform moment factor Cmy is set according to table 18. Uniform loading 
(column 3) and maximum bending moment in the field (diagram 3) are assumed. 

0.0    10.0 / 0.0   M / M    syhyhy ===α  

0.95    0.0  0.05  0.95    0.05  0.95   C hymy =⋅+=α+=  

1.069    0.27  0.2)    (0.4581    n 0.2)   (1   K yyy =⋅−+=−λ+=  

Bending about z-Axis (Minor Axis) 

The equivalent uniform moment factor Cmz is set according to table 18. Concentrated load 
(column 4) and maximum bending moment in the field (diagram 3) are assumed. 

0.0    7.5 / 0.0   M / M    szhzhz ===α  

0.90    0.0  0.10  0.95    0.10  0.90   C hzmz =⋅+=α+=  

1.286    0.40  0.2)    (0.9081    n 0.2)   (1   K zzz =⋅−+=−λ+=  

Lateral Torsional Buckling 

0.95    C   C mymyLT ==  

0.97    
0.25)    (0.95

0.27  0.779  0.1
    1    

0.25)   (C

n  0.1
    1   K

mLT

yLT
LT =

−
⋅⋅

−=
−

λ
−=  

Design in STEEL IS 

 Bending Moment Diagram Diagr My 3) Max in Field   Table 18 
 Bending Moment Diagram Diagr Mz 3) Max in Field   Table 18 
 Hogging Moments Ratio ψy 

0.0   Table 18 
 Hogging Moments Ratio ψz 0.0   Table 18 
 Hogging Moment Mhy 0.0 kNm  Table 18 
 Hogging Moment Mhz 0.0 kNm  Table 18 
 Sagging Moment Msy 10.0 kNm  Table 18 
 Sagging Moment Msz 7.5 kNm  Table 18 
 Ratio Mhy / Msy αhy 0.0   Table 18 
 Ratio Mhz / Msz αhz 0.0   Table 18 
 Load Type Load y Unif. Loading   Table 18 
 Load Type Load z Conc. Load   Table 18 
 Moment Factor Cmy 0.950   Table 18 
 Moment Factor Cmz 0.900   Table 18 
 Moment Factor CmyLT 0.950   Table 18 
 Interaction Factor Ky 1.069   9.3.2.2 
 Interaction Factor Kz 1.286   9.3.2.2 
 Interaction Factor KLT 0.970   9.3.2.2 
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Buckling about y-axis (Major Axis) and Biaxial Bending  

   0.27    1125.82 / 300.0   P / P   dyny ===η  

   0.09    106.591 / 10.0   M / M   dyymy ===η  

   0.28    27.273 / 7.5   M / M   dzzmz ===η  

   

Proven     1.0    0.55    0.28  0.90  1.286  0.6    0.09  0.95  1.068    0.27      

  C K 0.6    C K         

 
M

M C
K 0.6    

M

M C
K    

P
P

    

mzmzzmymyyny

dz

zmz
z

dy

ymy
y

dy

⇒≤=⋅⋅⋅+⋅⋅+=

η+η+η=

++=η

 

Design in STEEL IS 

 Compressive Design Ratio ηny 0.27   9.3.2.2 
 Bending Design Ratio ηmy 0.09   9.3.2.2 
 Bending Design Ratio ηmz 0.28   9.3.2.2 
 Design Ratio η 0.55  ≤ 1 9.3.2.2 

Buckling about z-axis (Minor Axis) and Biaxial Bending  

   0.40    742.5 / 300.0   P / P   dznz ===η  

   0.12    86.044 / 10.0   M / M   dyymy ===η  

   0.28    27.273 / 7.5   M / M   dzzmz ===η  

   

Provem     1.0    0.84    0.28  0.90  1.286    0.12  0.97    0.40      

  C K    K         

 
M

M C
K    

M

M
K    

P
P

    

mzmzzmyLTny

dz

zmz
z

dy

y
LT

dy

⇒≤=⋅⋅+⋅+=

η+η+η=

++=η

 

Design in STEEL IS 

 Compressive Design Ratio ηnz 0.40   9.3.2.2 
 Bending Design Ratio ηmy 0.12   9.3.2.2 
 Bending Design Ratio ηmz 0.28   9.3.2.2 
 Design Ratio η 0.84  ≤ 1 9.3.2.2 
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